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alnsallviuazdidansafindidauan-
WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation in national take-back initiatives
and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and related
packaging material) in accordance with all
Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/

about/sustainability/ourenvironment/
productrecyclingservices.page


http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
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b nmstiade

- dfvdendunau uazvinnsdiadoln
AUyl

. ﬂmgﬂm‘mu‘jm‘iﬂ‘il,l,nsu"l,éuﬁomnﬁms
ARG

« apanavnsdatusunsulunonds
ARINTaARNTIVIIVRALULARA VL
wiauauLAsaviia’le

PHILIPS www philps.comiwelcome

Monitor driver and software installation

wsnaa wla -Wizard (6h202a8519)

+ lunfousandvannmsing
SmartControl Lite ta3avaziila Wizard
(faneasy) duiniaada Tulhd iy
astdaTdsunsuassusn

. GTm':}Uafwamu:ﬂmmﬁ'mﬁ“nmsﬂﬁ”u
ALAALANINTTAULUDIADNTNUBIAMUT
azduUAaU

. ﬂ,qummsﬂflﬂﬁtyu Plug-in (wandu)
tRatdadzasgslunandelatuudu

. ﬂcumyjsnﬂfuﬁ?l,ﬁa@ﬁhoq L’WLJJL(?]JJI
Tag'luaavluaimassviaalanuiaig
Standard (unesgu)
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SmartControl Lite PHILIPS

Wizard

lbrate your display to get the most
/e encourage you to use the simple

]

Adiust ‘Atdo

Auto it

i

Color Input

a

€

W
2
Options Presets

MuEi Moncors

®

Help

Start Weard

B @ueusnauinaie Standard
(uassu):

wiy Adjust (d5u): ;

+ iy Adjust (U5u) auanaluaailiu
Brightness (aau&n1y), Contrast (aa
uns&n), Focus (TnAa), Position
(6nu1iug) wag Resolution (Au
EHLET))

. qmmmmmmwﬁumau wazvinnslsu
an

+  Cancel (anidin) avanuglznnanasnis
gntdnnshinaenIa’ly

PHILIPS

8 smartcontrol D

SmartControl Lite

Brightness
Improperly adjusted Brightness wil result in a loss of
detal n darker mage areas. Adiust the Brightness for

the best possble piture

the minimum level,
e dested level,

Adiust
Brightness
Color E/s
Focus it
| ¥ - :
Options Undo Reset

o

Help

12

8 smartcontol

SmartControl Lite

Adjust
Brghtess
Contrast
Color S
" Focus
2N
\g Postion
Optons
W
. Resoution
Help

8 smartcontol

SmartControl Lite

Adjust
Brightness
Contst
Goor an

- “ Focus
.
\ Postion
Options x
. Resobeon
Help
B smartcontrol

SmartControl Lite

]

Adjust
s
\g Contrast
Color ~n
A
. s
—
\,EE? odbon
Options
"
Reskton

—_—

Help

#x
PHILIPS

Contrast

Adjust the Contrast (use the sider) to keep detaiks i
ghter image areas.
1. Raie the Contrast unti the numbers 1 and 2

Contrast 50

Undo Reset

mx

PHILIPS

Focus

y's timing needs to be synchronzed with
al

visble, you'l need

Pitch: Try to make the vertical bands disappear.
Phase: Adjust to the brightest setting to minimize
movement on the screen

Pech 50

- +

Phase 7
Undo Auto Setup

@

PHILIPS

Position

Use the Position buttons to center the image on
your display. Using this tool, you can postion the image
up, down, lef, or right

1. Use the Up/Down buttons to center the image

e Left/Right buttons to center the mage
horzontaly.

Undo Reset



8 smartcontol

SmartControl Lite

Help

Brightness

Contrast.

B

Focus

3

Postion

]

)
ki
£
g

wiy Color (&): 5
1y Color (&) augalvaalsy RGB,
Black Level (szdu&sin), White Point

(am&w17), Color Calibration (n1515u
aud) was Smartimage Lite

Aarssavihadunay wagvinnisuiy

2k}

PHILIPS

Resolution

You are currentl at a Preferred resolution. For your
o show crisp, clar text, colors, and mages,

your diplay should be set to s Preferred resoluton.

I your dispay i at 3 Non-Preferred resolution, cick

on the Preferred button to change your resoliton to

I Enable Resoltion Notfier

Picture Format.
I 4:3 aspect ratio

Preferred

R

I

AANTIVATURI zdmsnswmsmuuau
audsiaalauianlyl

dratnva sy Color Calibration (A5
d5uiiaug)

8 smartcontol

SmartControl Lite

]

Adiust

X

Optons

®

Help

RGB
Back Level
Whte Pont

Display Gamma
L
Cobaton
@b

4

Smartimage

PHILIPS

Black Level

Improperly adjusted Black Level wil result 1 3 loss of
detal n darker mage areas. Adjust the Black Level for
the best possble piture qu
1. Adjust the black level of the Red, Green, and
Blus using the sider bars

Red 50
= @ +
Green 50
- +
Blue s0
= @

Undo Reset.
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SmartControl Lite

n
o

Adjust
= a

Back Level

GO wngm

Display Gamma

=

Options Calibration
ap
sriface
Help
B Smartcontrol

SmartControl Lite

Adjust RGB
e
Color White Point
Display Gamma
-
Options. Calibration
D
&
e
Help
W smartcontrol

SmartControl Lite

U 1]

Adjust RGE
Color. White Point
A =
!
Options Calibration
ap
.
Help

PHILIPS

White Point

White Point s the pont at which equal combiations
ofed,green,and b gt o ul ety crete
white. Ths effects the overal color quaty. For the
rost sccurate calos ick the Reset button then
select the White Point.
1. Please select the White Pont value for the best
possble color quaky.

6500K.

Undo Reset.

PHILIPS

Display Gamma

Gamma is 3 component of the pivel brightness in 3
dspay. A lower Gamma value produces brighter pxels
and a higher Gamima value produces darker pixels. The
default vabue for Gamma & 2.2.

o adjust Gamma, Smartimage must be set to OFF.
Cick the SmartImage Off button before adjusting
Gamra,

1. Use the sider to select the desied Gamrma,

Disply Gamma 22
= ® +
Smartimage Off
Undo Reset.

@

PHILIPS

Calibration

Your dsply needs to be properly calibrated in order
for & to produce the widest range of cokrs accuratly.
Calibration should always take place as the kst tunng
step in the process. Remember to recalbrate any time
You meke ndvidual adjustments to image quaky or
whenever you move your dsplay to 2 new location.
Make al other necessary adjustments to image

qualty fist.

2. Pres Show Me t eam how o use the
calibratiol

3. Faly tess Start o begn the calbration
process

R Enable color caibration
Color software desgned i colaboration with Joseph

Holes.
Protected by U.S. Patent fo. 6,686,953

Show Me start

Quick View.



1. "Show Me (uanaluig)" Bunsaauiied
AuasdsuiiAaud

2. Start (u) - GuasauATLiLAnUR
6 dunau

3. Quick View (gagn9is) Twannwnau/
BN

4. Tunsaduludonunaendn Color (R),
adnydu Cancel (antdn)

5. Enable color calibration (1davineiunis
ﬂsumunﬁ) amBuaudada a1lule

YRR mmﬂmwn"luauzy'm'tﬁ

vinnsdsueud du "Gu" wag "gaeng

157" azduinnang

6. aaviuayadndiiaslunuiaanisisu
LAEY

nuan1slEmnaudusn:

. ﬂu Previous Qnauum) gnilan1svineu
aunseiofonunaadiaas

«1fu Next (da'ld) Mdouhwinanaty (6
thwune)

. :.luﬁm”l,ﬂammm"“l,ﬂﬂwu'lmo
File>Presets (lWa>wiidin)

+ Cancel (anidn) fla UI uaznau'lalde
11 Plug-in (w&ndu)

SmartImage Lite
agmm‘m@‘Lmﬂauuuﬂmmiﬁam Waln

PP

Tan1saemINITUEAYNANATUAINLTANN

\adean Entertainment (Autiuiie),
SmartContrast wag SmartResponse agiila
iU
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SmartControl Lite PHILIPS
SmartImage

Smartimage provides diferent brightness and
contrast leves to accomodate today's wide range of

]

Adiust RGE
]
Black Level

Whte Pont

Disply Gamma

e g‘ﬁ

Options Calbration

@p

Smartimage

)

Game

o R

Internet

®

Help

Standard

Options>Preferences (mman>ms
fuadnuai) — avvinnuawisialdan
Preferences (nsAnniuadnmaie) NLUY
Options (stdan) vuaaugaIkaililasy
miaunﬂuuﬁnmmmmm DDC/CI, sl
Lawm,w!:u Help (38%2) uaz Options (&
tdan) iy

8 smartcontol 2%

SmartControl Lite PHILIPS
Preferences
o can st ot oo o COnRRRe
aron
G4 en right-cicking on desktop
\Q pﬁgem
. @ 0% f‘ 50% € 100%
Laish Audio Select language:
|Engiish ~
\g Auto Pivot
-
Color Input
g 22 .
Waard
8

E
Options Presets

Muki Monicors

®

Help

. u,ammss?ammsﬁ’mum‘l”m:rm“ﬂaaﬂu

. naaommmiawmu lunsidavineu
ﬂmﬂﬂﬂﬁ naaommsaoummﬂums
ﬂﬂlliu'ﬂ'.l'\\'lﬂ'\iVI']\'l']ﬂLLﬂuleVI'l\ﬂu

+ Enable Context Menu (1favinonuiuy
vlaw) numanmaﬂa”ﬂnmmsawmu
(\fla) muABuaY Enable Context
Menu (tdavinorumyiiiani) uaaanis



t’anuay SmartControl Lite &hunsu
Select Preset (tdanw3ida) way Tune
Display (5uaausdavna) uyiiam
Ain&@nauueanvay Disabled (fla
*vn\nu) au SmartControl Lite anawuy
amindnan

+ ‘lamau Enable Task Tray (1avinenu
a109u) gavinesaduung (a) o
AGuaU Enable context menu (1ia
vinouuiiam) uaaomyannu .
& usu SmartControl Lite Asa&nu
lanauaInu ALUFAIHILRANLUYAIIY
&y Help (381%), Technical Support
(mMsafuguuaunaiia), Check for
Update (asyagaumaniaa), About
(tAendu) way Exit (aan) ila Enable
task tray menu (tilavinouuyana
syuy) gnilavinou lasauangaszuuay
wagavtanng EXIT (aan) tnmiu

+ Run at Startup (3uifiaduau) gavin
tezavnang (ta) euaGuau tla
flavinonu, SmartControl Lite (s
smﬂauima 1an) a"”l,mflmwumal,sn
au 3aagluannu Fadafiazida
SmartControl Lite Adatdaannnadauu
wannail mamn‘lvxlaiﬂsu,msmmuu
wiidalaq Aideaiiasuiiazuay avly
9nTuan Wanaasilalavineasviane
ag (davineu)

+ Enable transparency mode (1iavinonu
Tualsela) (Windows 7, Vista, XP)
AmBGuauAa Opaque (Tiuuay) 0%

Options>Input (éndan>auna) — ay
viuawzdiaidan Input (Buwe) ann
tuy Options (éItdan) uulaudaINanlule
Sunsatusuuniiauaunsa DDC/CI, ay
mawutmn HeIp (3812) way Optlons (1
\Ran) winifu l,wm SmartControl Lite auq
Wonuaazlalule
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SmartControl Lite PHILIPS

Input

Adjust Audo

Analog In Digial In

uanIMINATuAaY Source (unag
dyaynan) uaznsdemunaddeyano
duwaifaqiiu

uuaauamwaﬁﬁﬁuwmﬁm wnenoiiay
uav'luwiy

Options>Audio (fndan>duv) — ay
viuawzdiaiian Audio (1&uv) anny
Options (d7tdan) tniiu
uuaau,amwaﬁ1ﬁié§unwsaﬁuauuﬁﬁmm
&unsa DDC/CI, agfiawizuniu Help (33
121) uay Options (§&an) wnifu

8 smartconol 2

SmartControl Lite PHILIPS

Audio

Adiust Audo

Color

100



Help>User Manual (5%’1?3>éﬁmi‘h§) -
agviouanziaiéan User Manual (ﬂua
N‘hj) Ay Help (331%) vulausanInai
"Lu"Lm'umsauuauumummajmsn DDC/
CI, qzmawqxulmu Help (331%) way Options
(dLlan) iy

# smartControl D)

SmartControl Lite PHILIPS

User Manual

Adjust

User Manual

Color -

Dispy ID

User Manual Tech. Support

Help>VerS|on (1s’l°u>nas°iiu) —ay
viuamwziliatdan Version (nasﬁ’u) N
iy Help (1ﬁ°l°u) vulauanINalulafy
miaunauumummﬂjmm DDC/CI, azfi
Lawwuﬁn Help (38%%) uaz Options (¢
t&an) iy

8 smartcontrol 7%

SmartControl Lite PHILIPS

Version

ne-plp-R2008-12-17-

Adjust n
v

p
\ ®
Color ‘“

:
Options x
;
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Context Sen5|t|ve menu (unm
ienaasduilan)

Context Sensitive Menu (Luuiil,ffingﬁao
Autlam) gadavinou muaBuau

a Enable Context Menu (1avingnu
wytiiam) gavine3asvanalumingie
Optlons>Preferences (mtaan>msmuum
dnmay) aaarnadiuluyil

g SmartControl
Select Preset L4
Tune Display

wiilaundi 4 shans:
+ SmartControl Lite — (flaldan About
Screen (tAgAUKUIAD) AUFAIAY

« Select Preset (manwsw’?m) Myt
vluadudunaswdidiadiuinly dwsu
Iﬂumumum Lﬂsawmuuamaowsw‘im
iidanlufaaiiu uanantl Aawaunsa 3
\an Factory Preset (witdinT5997u) ‘o
ANUYILNITENAIL

« Tune Display (U5urausauna) — tia
wHIAIUANUaY SmartControl Lite

+ SmartImage Lite - ATIAFAUAITHIAN
Ay iy Standard (11a531u),
Internet (Aumasiin), Game (1nx)

wiyaavuiaineu

ﬂmmmsnuammummm"l,éimﬂmsﬂﬁn
auu'lanau SmartControl Lite annana
91U Msadnanaazidaiadwdiatiu

Help

Technical Support
Check for Update
About

Exik




aavudd 5 s1ans:

.

Help (3&%a) — wnfioludo'lna User
Manual (ﬂuawhi) vila'lwa User
Manual (ﬂuaww) TaalauinaoLus
\asENAY

Technical Support (MsadusauuaIY
maila) — LEAVUUNANTIULRUUAIY
wmaila

Check for Update (as1agaumiduian)
— iy lalaldovin PDI uagasiaday
nasﬁ‘umam‘tﬂ WaufunastuAviusTe
ngand

About ({Aenf) — uaavzayaa19E
agvazaan: DasTuNAafiam, 1aya
U ualiandnfain

Exit (aan) — @@ SmartControl Lite

un1s¥u SmartControl Lite 8na%s
tdan SmartControl Lite a1nLuy Program
(Tdsunsu) wiaduiiandniilanau PC uu
wannal wiakuszuulnu

PHILIPS

SmartControl

SmanControl
Version 3.20
dhune-standard-R2007-01-04-1151-23
Copyright 1983-2007 Partrait Displays, Inc.
Patents Pending

wiyaavuiaiineu

Waananugniarvineululnawmas ns
Amuadnmay Wwwizseals EXIT (aan)
nanunsalyle wiaay SmartControl

Lite aanannanaszuvasvauysal 1ude
¥i191u Run at Startup (Futiiazuau) Tu
Options>Preferences (fLdan>n13A1nua
ANEUY)
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S uunLLuia

mwﬂs”naumwm‘lumuu ‘Lmh‘visn
Arsa19AaLiY nasﬁumaﬂmns ‘
SmartControl mmﬂaﬂuu,ﬂaa"l,mimu"tu
aagualinny Tusaasagauiu'lae
wasmseagadumenisy www. portrait.

com/dtune/phl/enu/index Lwam:u‘iuam

aiaWa s SmartControl Laasﬁ’umamaua


www.portrait.com/dtune/phl/enu/index
www.portrait.com/dtune/phl/enu/index

4. AayaINNITAULINATLA

AN/ QUAAIHNA

AUAUDIIDAN IPS LCD; TFT-LCD (277E6LDAD/277E6LDAW)
wualan LED

AUIAKUIAA 27W (68.6 2fu.)

ARAEIUMNW 16:9

AUANALUR 0.311 x 0.311 ax.

AN 300cd/m?2

SmartContrast 20,000,000:1

dnsmaunas (') 1000:1

nateauduay (17'a) 14ms; 5ms(277E6LDAD/277E6LDAW)
SmartResponse 5ms(GtG)

ANURLLALANANFA 1920 x 1080 @ 60Hz

- 178° (H) / 178° (V) @ C/R > 10

' 170°(H) / 160°(V) @ C/R>10 (277E6LDAD/277E6LDAW)
ATLAUAUNINADINN SmartImage Lite

gnuaavle 16.7 M

AR5 ULUINY 56Hz - 75Hz

ANuALUIUAY 30kHz - 83kHz

MHL 1080P @ 30Hz (277E6QDSW/277E6QDSD)
SRGB i

ANUFINIsanuNSLTiaua:

dunadeyana

277E6QSD/277E6QSW: VGA (aunaan), DVI (#dnaa)
277E6QDSD/277E6QDSW/277E6LDAD/277E6LDAW:
VGA (auaan), DVI (#3naa), MHL-HDMI

277E6QDSD/277E6QDSW: &t PC 10, yWvaan

LSRN 277E6LDAD/277E6LDAW: 12 1awai&eg HDMI
feyanaudune qGoaunan, Goauudilien
ANUAZAINALNE
277E6QSD/277E6QSW/277E6QDSD/277E6QDSW
o 900 &/« /v /A B/0K 0)
ANEEMARINL BT 277E6LDAD/277E6LDAW:
ED/« /v 10/a /0K Q)
dunam, wasiu, duly, n3n, WA, 8and, §9n13,
LLEATUAUR, s, Tsang unda, Tluaua, Saude,
A1 OSD
o, Aunaua, a3, 1iin, ATy, auuwumu’mm
au"l,mmu iy, 1l
ANUREAINIUNELIAUY daa Kensington

ANMNFNITAMUNIN & LWAE
21619
HIN

DDC/CI, sRGB, Windows 8/7Vista/XP, Mac OSX, Linux

-5° [ +23°
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277E6Q/277E6L:

WU

Tuuadaadag

277E6QSD/277E6QSW: 26.88 W(¥ia'lal), 27.12 W(gewn)
277E6QDSD/277E6QDSW:26.28 W(vi2'l1l), 26.48 W(goqn)
277E6LDAD/277E6LDAW: 26.28 W(12'll), 26.48 W(g9an)

adl (vt

0.5W

e (v'1l)

0.3W

1WugavsaIug LED twias

Tnadae3a: &1, Tnuaauauauna/a81: &u10 (nzwsu)

urade'lu

anauan, 100-240VAC, 50-60Hz

Unuiin

HAMAUNWIANUGY

(NX&XA) 640.3 x 478.6 x 235 wu.
nadaufatitangg 640.3 x 394.3 x 48.2 .
(NX&XA)

5.42 nn. (277E6QDSD/277E6QDSW)

NAAAUNWIANUGY 5.28 nn. (277E6QSD/277E6QSW)
5.44 an. (277E6LDAD/277E6LDAW)
L 5.17 an. (277E6QDSD/277E6QDSW)
waasaniiialulagunang 5.03 nn. (277E6QSD/277E6QSW)

5.19 nn. (277E6LDAD/277E6LDAW)

wauluanisvinvnuy
29aaunndl (argvineu)

0°C &9 40°C

2vaaun)dl (agluvineu)

-20°C &v 60°C

ANUAAAAIDILATHINTFIU

asausiduassuifisuna
TIALANY9

Anududuing 20% #v 80%

MTBF 30,000 2.

ROHS 1

EPEAT sEadu (www.epeat.net)
usTfiaun 3Flaida’la 100%

EREIHY RH MLAzadnlsaann PVC BFR 100%
Energy Star i

277E6QSD/277E6QSW: 1a3adnune CE, FCC aan& B, CU-
EAC, SEMKO, 1u5usav TCO, ETL, BSMI, 1S09241-307,
SASO, KUCAS, EPA, C-TICK aa& B
277E6QDSD/277E6QDSW/277E6LDAD/277E6LDAW:
1A3avnune CE, FCC aana B,CU-EAC,SEMKO,1ususas
TCO,ETL,1S09241-307,SASO,KUCAS,EPA, KCC, VCCI aan#
B, C-TICK man& B

Gitn5av
& wUdALas/&un
HNURD T
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www.epeat.net

S uuLLin

1. EPEAT wdneumasniandoandu la'la
wwnziia Philips aongifiaunandoun
Tusaufiauaui www.epeat.net & 1usu
ganugnisasnetiaululssinauasna

2. vayafianauldsunlaslaiaalunasuas

Wnsu U7 www. philips.com/support
WasmuTuaauruzayanasiuaagn

oo s

3. nanauduaddaRsuviumidigaain
AMnasau GtG wia GtG (BW)

20

41 anuaziduea & TUUANSLEG

b enwaznduagedn
1920 x 1080 @ 60 Hz (Auwmaundan)
1920 x 1080 @ 60Hz (Aunnaurdan)
H arnuandaaiiuunin
1920 x 1080 @ 60Hz (Auwmaundan)

ANuduua A2 n'av'mé"\u,m

uau (kHz) azndun 6 (Hz)
31.47 720x400 70.09
31.47 640x480 59.94
35.00 640x480 66.67
37.86 640x480 72.81
37.50 640x480 75.00
37.88 800x600 60.32
46.88 800x600 75.00
48.36 1024x768 60.00
60.02 1024x768 75.03
63.89 1280x1024 60.02
79.98 1280x1024 75.03
55.94 1440x900 59.89
70.64 1440x900 74.98
65.29 1680x1050 59.95
67.50 1920x1080 60.00

S uuun

‘IﬂmmsmiwauﬂmNa‘uammﬁwmiéﬁ
mammmma LdaeunasgIu 1920 x 1080
@ 60Hz Lwaiuimﬂmmwmmﬂmwamm
mam 'I‘ﬂ‘smmmumumuﬂumsmmmm
aviduai


www.epeat.net
www.philips.com/support

5. ANSAANAITNASIIU

mﬂmumsmt&mwamm{aﬂmmm
fanaaaddu VESA DPM mmmaaﬂ‘lu PC
YA aaquuammsamﬂaaawaomu
‘imﬂamiuumiummvm"lu“l,mﬁmu msma
wumsﬂawauamnuﬂuwuw Lma wia
aﬂnsmﬂauwauaauq aanwag "fudy”
TaadnTulit m'm\ma"LﬂuLlemmsauLﬂaao
WAIIU LLaumsmé’muzywvmﬂaaamaunmms
UsznfianavnudnTulind:

277E6QSD/277E6QSW:
ANURUILUDINITIANTWAIIIY
foa | @A
\TI‘E’SJX 3812 | ww | uw | wdeewilly | &LED
uau a9
26,88 W
_ R ; ; (vhl)
wanin 0] o 1L 2712 W dum
(g9d0)
a8l | eu | M| W | 05w (nﬁxﬂa)
faadas |y - - | 03w () M

277E6QDSD/277E6QDSW/277E6LDAD/277
E6LDAW:

ANUNRUELUDINTIANITWRIIY

dva | @A
\i;g’ij 38%a | ww | wn | wdeowilly | &LED
uau a9
2628 W
I - - ()
waniin L) Taf T 26.48 W &
(F9g0)
add | du | | B[ oswh) | n‘fﬂ;’u)
fowe3as | du - - | 03w (vhlal) fu

nsaemaaldiignlaiadanisdunldas
W& UL Wil

o anuastdaaunasgIu: 1920x1080
«  AaUNTER: 50%

« anuaNe: 300 nits;

«  auugiad: 6500k wsangUuuudnd
Uy

S vunuin
°uauaumaLﬂaﬂuu,ﬂaa"Lm‘imn”lmaaLm‘lu
Iy
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6. A_YALNLINUSCLL AL
AdLUIAL
Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This product is designed for both you and the
planet!

TCO Development works for
sustainable IT - manufacture,
use and recycling of IT products

reflecting environmental, social and economic
responsibility.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for ICT products worldwide.

Some of the Usability features of TCO
Certified Displays:

e Visual Ergonomics for image quality
is tested to ensure top performance
and reduce sight and strain problems.
Important parameters are Resolution,
Luminance, Contrast, Reflection and Colour
characteristics

*  Products are tested according to rigorous
safety standards at impartial laboratories

»  Electric and magnetic fields emissions as
low as normal household background levels

*  Workload ergonomics to ensure a good
physical environment

Some of the Environmental features of TCO
Certified Displays:

¢ Production facilities have an Environmental
Management System (EMAS or ISO 14001)

* Low energy consumption to minimize
climate impact

* Restrictions on Chlorinated and
Brominated flame retardants, plasticizers,
plastics and heavy metals such as cadmium,
mercury and lead (RoHS compliance)

* Both product and product packaging is
prepared for recycling

*  The brand owner offers take-back options

Corporate Social Responsibility

* The brand owner demonstrates the
product is manufactured under working
practices that promote good labour
relations and working conditions.

The Criteria Document can be downloaded
from our web site. The criteria included in

this label have been developed by TCO
Development in co-operation with scientists,
experts, users as well as manufacturers all

over the world. Since the end of the 1980s
TCO has been involved in influencing the
development of IT equipment in a more user
and environmentally friendly direction. Our ICT
product labeling system began in 1992 and is
now requested by users and ICT-manufacturers
all over the world.

For displays with glossy bezels, the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

For more information, please visit:
www.tcodevelopment.com

I[n Technology for you and the planet
CERTIFIED

(Only for selective models)

User mode is used for TCO Certified
compliance.


www.tcodevelopment.com

EPEAT

(www.epeat.net)

)  The EPEAT (Electronic
Q?:b Product Environmental

& Assessment Tool) program

evaluates computer

desktops, laptops, and monitors based on 51

environmental criteria developed through

an extensive stakeholder consensus process

supported by US EPA.
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EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the

design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact

of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S

requirement that all registered products meet

ENERGY STAR's energy efficiency specifications,

means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

EN60950-1:2006+A11:2009+A1:2010+A
12:2011+A2:2013 (Safety requirement of
Information Technology Equipment).
EN55022:2010(Radio Disturbance
requirement of Information Technology
Equipment).

ENS55024:2010 (Immunity requirement of
Information Technology Equipment).
EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).
EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker).

EN50581:2012 (Technical documentation
for the assessment of electrical and
electronic products with respect to the
restriction of hazardous substances)

EN 50564:2011 (Electrical and electronic
household and office equipment —
Measurement of low power consumption)

following provisions of directives applicable

2006/95/EC (Low Voltage Directive).
2004/108/EC (EMC Directive).
2009/125/EC (ErP, Energy-related Product

Directive, EC No. 1275/2008 and 642/2009
Implementing)

2011/65/EU (RoHS Directive) and is
produced by a manufacturing organization
on 1SO9000 level.

And is produced by a manufacturing
organization on ISO9000 level.

1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.


www.epeat.net

Energy Star Declaration

(Www.energystargov)

ENERGY STAR

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

1

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
l'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences


www.energystar.gov

nuisibles aux communications radio.
Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteun.

* Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander I'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

Thiz devica balongs to catagory B devices as described in EM 55022, unless it is specifi-
cally statad that it is a Class A davice on the spacification labal. The following apolies to
devioss in Class A of EN 55022 (radivs of profection up to 30 meters). The ussr of the
devics is obliged 1o take all stepa necessary to remove sources of interferenos io tels-
communication or other devicas

Pokud nenl na typovsm &t
spedd o tfidy B podie EN 55022, Pro zafizeni zafazend do tidy A {chranné
pésma 30m) podie EN 55022 platl nésledujicl. Dojde-li k rufien telekemunikataich nebo
Jinjich zafizeni fe ulivatel povinnen provést takowvd opatfgnl, aby rueni odstraril.

uvedano, 3 spadé do do tfidy A podia EN 55022,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor; printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/T-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacfi

Uszadzinie powlano byl zsilane 2 pniazds 2 preybezonyem abwodan ocheonsyes
ok spdlpracufice 22 soby urzsdsenia (kompuser, monitor, drukarka) pow
2 tapn smepn Hidla

Insialicja elekiryema, jrai w p rie o
¢ postaci bexpsecnin o wartosci mamionawe e w
TS 2 -.u.m easilania, nalezy wy

Jm aé i w poblia urz
potwierds € urzadzenia 2 wynig
o P T AP PR s

wivezkg kabla
i 1 byl Bt dostapine.

Znik beepieceettw
whytkowsitia Fwar

T —

Pozostale instrukcje bezpieczensiwa

* Nie maledy ulywad wiyesek sdapterowych lub usiwat klka abwodu ochrasnego 2 wiyezki
Tkl konsocine jest u{'_vt». presdluiacia o aalszy wiyé preedluiace S-iylowsgo -
i 0

- Nu. nalezy \wh.\un.‘ napodw and innych plyndw s sysiem komputerowy.

Nie maledy wpychaé indnyeh preedmiotio do atwordw systen komguteroweya, gy mate
ta spovwodowai podar lub poradenie pradem, poprzes cwarcie elementim wewngtrnych.
System komputerowy pawir E ikt i kel ciepla. Porssduo,
e naley blakawat abwordw wentylacyjmych. Nabesy anska kladzensa lainych papieri pod
kamputeT on umieszczania kompulera w ciasnym miejscu bez madiwaici cyrkulacii powi-
etrza wokél nicge.




North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Réntgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerédtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
lIl'a 5 Abs. 4 der Rontgenverordnung erfullt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

BSMI Notice (Taiwan Only)
RAZHERERZIDE |

Aus ergonomischen Grinden wird
empfohlen, die Grundfarben Blau und
Rot nicht auf dunklem Untergrund zu
verwenden (schlechte Lesbarkeit und
erhéhte Augenbelastung bei zu geringem
Zeichenkontrast wéren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

(N ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.




China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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EU Energy Label
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The European Energy Label informs you on

the energy efficiency class of this product.

The greener the energy efficiency class of this
product is the lower the energy it consumes. On
the label, you can find the energy efficiency class,
the average power consumption of this product
in use and the average energy consumption for
1 yean

S&Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.
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7.2 asguaanal & AnssuilscAu

dvsurayadmAuanuanasadnalanissulssAy waznaminualunssiuauuLR G
‘L‘J.i”l,méimsnnumﬂmaaﬂm ‘Eﬂmmumjumnﬂﬂm www.philips.com/support & miusiaazidan
uanajgu AaLEINTAfaRaNINaIRAAUINTaULAgNA1ad Philips Mulssinauasnuinansnu
av'laade

Aayafinnadiviuninia gisdaziuan:

szind CsP vunaaadaalay 5780 nalinis

Austria RTS +43 0810 000206 €0.07 Mon to Fri:9am - 6pm
Belgium Ecare +32 078 250851 €0.06 Mon to Fri:9am - 6pm
Cyprus Alman +800 92 256 Free of charge |Mon to Fri:9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri:9am - 6pm
Finland Infocare +358 09 2290 1908 Local call tariff | Mon to Fri:9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri:9am - 6pm
Germany RTS +49 01803 386 853  |€0.09 Mon to Fri:9am - 6pm
Greece Alman +30 00800 3122 1223 | Free of charge [Mon to Fri:9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff | Mon to Fri:8am - 5pm
[taly Anovo ltaly +39 840 320 041 €0.08 Mon to Fri:9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff | Mon to Fri:9am - 6pm
Netherlands Ecare +31 0900 0400 063  |€0.10 Mon to Fri:9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff | Mon to Fri:9am - 6pm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri:9am - 6pm
Portugal Mainteq +800 780 902 Free of charge | Mon to Fri:8am - 5pm
Spain Mainteq +34 902 888 785 €0.10 Mon to Fri:9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff | Mon to Fri:9am - 6pm
Switzerland ANOVO CH | +41 02 2310 2116 Local call tariff | Mon to Fri:9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri:8am - 5pm

Jayadnnaduisugiinia azduawdn:

szine maatduinas vunaaaniaguagudinag
Brazil 0800-7254101

- Vermont
Argentina 0800 3330 856

Jayadineadnsu fu:

iszine
China

maatdulaas
PCCW Limited

vunaaaniaguagudinag

4008 800 008



www.philips.com/support

Aayafinnadiuiuninia glsdnavuazaciuaan:

A

Huinas vunmannhaguagudina
+37517 217 3386
Belarus N/A IBA +375 17 217 3389
Bulgaria N/A LAN Service +359 2 960 2360
Croatia N/A MR Service Ltd +385 (01) 640 1111
Czech Rep. N/A Asupport +420 272 188 300
+372 6519900 (General)
Estonia N/A FUJITSU +372 6519972 (workshop)
Georgia N/A Esabi +995 322 91 34 71
+36 1 814 8080 (General)
Hungary N/A Profi Service +36 1814 8565 (For AOC&Philips only)
Kazakhstan N/A Classic Service llc. |+7 727 3097515
+371 67460399
Latvia N/A ServiceNet LV +371 27260399
+370 37 400160 (general)
Lithuania N/A UAB Servicenet +370 7400088 (for Philips)
Macedonia N/A AMC +389 2 3125097
Moldova N/A Comel +37322224035
Romania N/A Skin +40 21 2101969
Russia N/A CPS +7 (495) 645 6746
Serbia&Montenegro N/A Kim Tec d.o.o. +381 11 20 70 684
Slovakia N/A Datalan Service +421 2 49207155
Slovenia N/A PC H.and +386 1 530 08 24
the republic of Belarus | N/A ServiceBy +375 17 284 0203
Turkey N/A Tecpro +90 212 444 4 832
Ukraine N/A Topaz +38044 525 64 95
Ukraine N/A Comel +380 5627444225

Jayadinaadnisu amsnuiia :

ssine maatduinas vunaazrhaquanusina
USA. EPl-e-center (877) 835-1838
Canada EPl-e-center (800) 479-6696
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Aayafianad1nsuninna APMEA :

szind ASP winaauchaquangusina navinns
Armenia
Azerbaijan Firebird
Georgia . +97 14 8837911 Sun.~Thu. 09:00 - 18:00
service centre
Kyrgyzstan
Tajikistan
AGOS
Australia NETWORK 1300 360 386 Mon.~Fri. 9:00am-5:30pm
PTY LTD
Company: Hong Kong:
Hong Kong Smart Pixels | Tel: +852 2619 9639 Mon.~Fri. 9:00am-6:00pm
Macau Technology Macau: Sat. 9:00am-1:00pm
Ltd. Tel: (853)-0800-987
. REDINGTON | Tel: 1 800 425 6396 .
india INDIA LTD | SMS: PHILIPS to 56677 Mon.~Fri. 9:00am-5:30pm
+62-21-4080-9086
Indonesia E—EI—RS/ICSIT\IVI%(C:) (Customer Hotline) Mon.~Thu. 08:30-12:00; 13:00-17:30
+62-8888-01-9086 Fri. 08:30-11:30; 13:00-17:30
PERKASA .
(Customer Hotline)
lsrael E?sgro”'cs 1-800-567000 Sun.~Thu. 08:00-18:00
Alphascan Mon.~Fri. 9:00am-5:30pm
Korea Displays, Inc 1661-5003 Sat. 9:00am-1:00pm
, R-Logic Sdn Mon.~Fri. 8:15am-5:00pm
Malaysia Bhd 603 5102 3336 Sat. 8:30am-12:30am
New Zealand \L/t'fj”a' Group 1 0800 657447 Mon.~Fri. 8:30am-5:30pm
Pakistan T\/Q,\“CS +92-213-6030100 Sun.~Thu. 10:00am-6:00pm
Pakistan
EA Global
Philippines Supply Chain | (02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm
Solutions ,Inc.
Philips
Singapore Pte .
. 4 Mon.~Fri. 9:00am-6:00pm
Singapore Ltd (Philips (65) 6882 3966 Sat. 9:00am-1:00pm
Consumer
Care Center)
Computer
South Africa | Repair 011 262 3586 Mon.~ Fri. 08:00am~05:00pm
Technologies
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7. nsquagnal waza1ssuilszdiu
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8. msun“tmﬂmw\ &
Ao uRwLILag

8.1 asun'laidain

Muwuﬂswnanmuﬂmmmoq mmmsnun“l‘u
1alaayly anfayndonsiag navaniaa
aanﬁmmn"lmﬂmmmmuu,m Wdana
mLLmudmusmsaﬂmmaa Philips

H eyl

dinw (LED m'\nas"lumm)

. maam‘luuu‘ta'ﬂmﬂwLauuaﬂnu
wdauliwh wasidavagdeunds
AADMN

o wsnga Wwulanduminasiaiumnin
aagaanwaglusiuviue OFF (fa) ann
Hunmfulydosiiuviug ON (i)

1dinaw (LED wnasuludana)

« anglunulanmauiinasiiaag

. msaam‘luLLu‘tmmmmmaﬁmmmeﬁau
ma"Lﬂuaﬂauwamasmammamammu
&

« anagiuuulanaaaiialanwlufion
Mavuaunladmiuiiauna adl u
aauvdaldlausnaialia

+  aadudfmssendandvouaiada
vinvuag

'I)iﬁ‘lﬂﬂllﬂﬁ\‘i‘[lﬂﬂ’)’lﬂ

Attention

Check cable connection

« anagluuulanaaiaidasaniwidan
aa'lddmaufiiinasuasnqianIotnung
au (lugaliaduaualivaaisynaunie)

« anadauiagnamadaanwiani
vansa'ly

« anagluuulaneanfianasidaas
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1ln AUTO (ﬁmiuaﬁﬁ) vty

o WendudaTuld lalataniy maaﬂ‘lu
Tnua VGA- aundan mwaaw'ﬁ"l,mﬂum
wala ﬂmmmsnmmsﬂsnmmoq wuy
Lmuum"lmmumu 0OSD

6 uNLIe

Wondiu Auto (FaTuilfd) 1rlulalulnue
DVI-Digital(DVI-#3saa) tiiavannluiininu
Ailu

wavtiiuaiundalsznan
« amenfiudunaunisunlatymian

o dansdannarnnInAINURAINAINIY
nanufA iamNlaaasia

«  faeadunurauinisgnauas Philips
uii

H dayunaurdunin

AMwliagasenany o
o susunuwinwiaaluWendu "Auto
(F07w16)" Tudrmuaunanuas OSD

o dsusdunuenniaalawendu Phase/
Clock (vWa/u1nn) wav Setup (mm)
Tudrmuaunan OSD asvinzuiilale
w1 luTvue VGA

Awduuunuiaa

. msmaannammmaﬁmmmlﬂamalﬂ
fansWAlnn1se wisa PC aenvlnineay
wasLuunuIVEa'ly

P P I
HUANTACTNIULUIAY

o dsusduwnuenniaalawendu "Auto
(FaTudd)" Tudrmuaunan OSD

o Adauauluwundelaaly Phase/Clock
(L‘Nﬂ/mﬂm) aav Setup (mom) Tuén
AuAuuan 0SD msviniuillalaianiy
TuTuua VGA

dn19nsWEULUIUAY




« dsusrunuenwiaalawendu "Auto
(80 Tuli®)" Tudrmuaunan OSD

o Adavauluwundelaaly Phase/Clock
(wWa/urnn) 2av Setup (ava1) Tudd
amuauuan OSD msvintuiilalatanny
TuTnua VGA

awilsinguaa Wwida uiadiaAulal
o USUAAUNIRALRYANMNAINILULNYT
WEAYUURUIRD

21115 "nwane”, "iisudu” uda "aw

Tnaa" uomaquﬁamnmﬂﬂm'saevlﬂum

. msludeFemsnisuaasnnieiidana
l,uam,f]u'sw gAY aNavinlvinnng
Lusuau Msamannu‘lummi "Aw
A" vida "mw‘l',nam" uuumaamaa
AL a1ng Lu‘suau" "awane” wia
"winge" Lﬂuﬂswngmsmmannum
‘Lumm‘iuiawmaa LCD mumnu,m
a1ANg Lusuau vi¥a "awae" vida
"WInae" a"ﬂam wiglddlanainu
11 ndsanniidaeiag

o davinouTdsuasuansuaninasifiang
waauluiaua Wanalaasaaniwiie
M laalutalzu

« dlavivuuadwfindudivisavunaa
viuszaeg &ua a1aan 1w LCD AAIA O
ayuamLuammﬂumwuaij’o"lmms
waaunilas

. ms”LaigfImiwmugn‘%uana% wiauail
wﬁtqﬂu‘%msmumamﬂyswm anauly
wa’tmﬁmmmg 2alvwn" wsa "nwaie”
wia ' mw‘Inam amaiuu,sa d9az'lu
we'lad ua""lummsamamwm“l,m AU
L?xluvnumnmgmmunu"lu"l,mnmw
AuAsasnalan1ssuLlseiunasnn

n'\wd‘smgﬁmﬁuu aaanululudia

vsaluaa

. demanuasidaansusainauag PC
‘Lm‘ﬂu'i‘vimmmnunummaumm
UIATFIUVAIATUIAINATILULUNUAY
@AW

Fad il Fuave #1du yadia uazdan

ﬂs’mguuumaa

.« aaflmfaagiunadnraslnduas
madamailalumaiuladilagii
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dgnfusaazidaatiuin Tusaguiaune
thenfuinia

M "laadas” anetdull uavsuniu

A151iN91U . }

«  aadusadiyld "idawedas” Tealy
Asd9AN LED Lwn)aﬂummuﬂuuan
OSD

dvsuanumhamdariugy eganns
AUEUDYRNUFTNA LRzAanafILNUNL
13n15gnA1ad Philips

8.2 @1auNWLLALY ADY
SmartControl Lite

f1anu 1. Gnnsudauaaniwuu

PC iluluaaniwiu uar
SmartControl Lite 121'lu'1a
mswmma"ls?

B3u PC i wazgn )
SmartControl Lite (&1151
AAUTNIA "Lm/l) &U150viN9U
"I,m/isa"lu "Lumuuu ey
AavAL Lgau@mmp ISmalrtControI(
Lite Tuu thaluiulaniesias
AMINZINGARAGY

Wendfu SmartControl Lite

muwm'm"lmn wouaneiila

ura) azvinaane'ls?

afinsafiunisea’laldl AMLAA

nifusasdadelasinasaanin

‘ i .

. Lﬂ?guuammﬂLmaﬁﬁianﬂWWanL‘ﬂu
nTRaAU

. dnea'lasnasifla

«  fiAanssuuu OS wulldeu Service Pack
w3a Patch

« 53U Windows Update wasduianaanin
way/lasnasifila

+  Windows nm‘lumm“mqamwﬁmmsao
wialiledaura

« lumseum Tisandnainii My
Computer (AauRIlnasuaddU) LAZARN
1 Properties (aau&uii6i)->Hardware

aau:

Aoy 2.

aau:



(m%mn%)»(Device Manager (6
Ann1sainsal)

ALY "Plug and Play Monitor (3a
AMWwanLauAWAL)" uiavtiuaala
Monitor ([anw), aavdiunasdinge
nu vAavau SmartControl Lite aan
wazfnag Ll

A0 3. udvanilinde SmartControl

Lite landnfiniiu
SmartControI Lite "luua.v"ls
uammummuue WdanamIu
aummuammum winazls
fiu?

Aqau:  anatdiasannasiailinasamwidn

a9l uTInAulelady
SmartControlLite. anazualinas
nswwﬂnmaoﬂmﬂuuua‘tuwam
AaNdvauuy Waasamulvan
1asasazualinasnsiWflniiluu
ganiulannas 3 ¥nang
mazymmﬂmaspswﬂﬂn
finsv'lasiias au SmartControl
Lite, uazdindelvudnase
anfema'luvineu sdalad
muao‘@umswmmswﬂﬂnavu.mj
Lmaé"l,u"lé‘fnmsaﬂfnauu Tilsa
Beuzuiulae Philips uazasa
faunfilasas SmartControl
Lite Adwiaauia’ly

@au 4. landni Product

Information (maua
wamnmm) fliuayaudneuny
fHumniiu iAeazlsiu?

daeau:  araduwsnglashasazuailnas

anuWAnnsauasaalalaiiy
nasfuiidwanlan imauuauu
Sumanva DDC/CI amoaunsm
Tisaaavamuvanlasiasay
watleasnwdnnsafidwan
maqznnrm"wm:uaom}:mammy
02N MANAISe Ganvlasas
au SmartControl Lite uas@inda
R URIER)

Attention

Theft Deterrence is Enabled

f1a7u 5. du PIN dhusuillendiu Theft
Deterrence (1avfiuns
ATuy) aavinauels?

dmau:  Auau3nis Philips fawnsau
UDYATIUFINUVDIAMUUATNT
auanavIngMINg aesa
gauanuiduiaizaduadaaniw
Tdsansrunendulasduatue
flulawddamnuasain g
Fan1svuneaiay PIN wuainu
fuRaraunavliunazaunsa
avansAdeaminaaaiiuaia
mmm unsdiAduvunaiay PIN
guau3nis Philips aunsasida
winaaaluduanlaafinisda
alaane udvanfinsiagay
anuduanzaduar Tusansu
7 Aanssuilulesuainuruasas
aaladaulurasnissudlsediu
WATFIU

8.3 araunnuuaug 'l

fd1a1u 1 Wwanzndadeannin A5
amo"lsn‘mu‘nauﬂmoman’nu
21 "Cannot display this
video mode ("lummsnuam
‘inummiau"lm)"?
fnau: ANuaridaauuzitdIniy
aanwil: 1920 x 1080 @ 60 Hz
- aanldnaamaidaonus annduidian
fa PC uadanznfuaanniinalztnau
windl
+  Tu Windows Start Menu (tuyi3nnad
Windows), t&an Settings/Control Panel
(nséemn/undaluax) u Control Panel
Window (Mina9undaILax), tdan
lamau Display (nsugaana) alalu
Display Control Panel (txgaiuaunns
LLamwa), tdanuviu "Settings (ms
mm) aalawiiu Setting (msma
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aau:

Aoy 3:

aau:

Arau 4:
fau:

A1), lunaasilda 'Desktop Area (Huit
wanmal)', daudidauldi 1920 x
1080 AnLaa

1ila "Advanced Properties (ﬂmﬂunm‘uu
F9)" uavdomdnsFinsalai 60Hz, an
un&n OK (anav)

BGumanieas vl wazvindhdusaud 2
uay 3 ansiagaudn PC uasnagnde
A7 1920 x 1080 @ 60Hz w3a'lu

ﬁmﬂamwumaswamm 02ADATNLAN
AaIALAAN wazifiaunaaaniw LCD
Philips zasaaunduian'lilanais

laraniwuadnn anntulila PC aasna

Aau 2: das3isaituusiindnus

[an " LCD datnmia?
assarinuzinluaaniw LCD
#a 60Hz Iunsn‘iﬁﬁﬂausumu
UUNINAA ﬂmmmsnmmamﬁ
HulsuAndulade 75Hz Lwam'n

adusumuifureldvia’ly

Wa .inf waz .icm uu CD-

ROM @aarl5? azdindelasas

1aawnvls (Linf uaz .icm)?
fdalWalasiasdiuiuaanw
aavnas Ufidaudunaulugia
widuasnaiadadalashas
panfImasa1aaudelasasuad
a2 (Ma .inf uag .icm) viza
wnu'lashas anaudadeaaniw
uasousn ﬂi‘]ﬁﬁmumumauma
& (wiu CD-ROM) Asnwsaudu
waasauni lasnasaanin (lua
.inf uag .icm) aggndindaiae
anTudd
avlfumuanidunlaannls?
“Lml,)as"";ﬁ'iams'ep/nsw\lﬂn Uay
AWWANUDIAMUALTINAUMN AN
avtdualale aaugunsatdan
ANuazdaainasnisaale
Control Panel (tWoaIuAN) 2@
Windows® luaa "Display
properties (AENLHNITULEAY
WR)"

A0 5: aziinazlstiunnaanudusu
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aau:

A0y 6:

aau:

Arau 7:

aau:

A1a1u 8:

aau:

Tuaazvinnsdsuaaniwnnu
osD? )
wiavnalu OK (anav), anniy
tdan "Reset (Gidin)" tlalzan
MsdmdaLinnastsesundudiu
1

vni'\aa LCD numan1sdiaaiu
1aalu?

el wuginnluaasiuiiu
wmuwaé’maqnn'ﬁnsuumnm
Juuse uarlasAululngningsi
au wiadnqlad wuaglufiaufnix
TunaeNIanIsAUININ 79I
uulanlufinsedu viausena
muumumﬂuumaauamwa
wuuLLY Asvinzuiianagenan
senududaulanissulssduaag
Aol

n’;svi"m'nyaza'mﬁuﬁ'mﬁ'\
a[a LCD aunv'ls?
dnsunsvinanuszanalng
‘Lu'wmuumaumm fniung
viaugzaafinagnIsiy

v uRLA Tﬂimiﬂj"l,a'im‘iwswa
LLaanaaaa am’mmma"muau
WU 1a%a Waanadaa, LasIuaa,
avdilau, LEALY, 14

aunsanlagunisdvanfuas
agn'lw"lén"sa"l,ul? 5
1o aardunsallaauulanisey
AmduavaatiuaImIuAu OSD
Taalgnszinunisaa il

na "OK" (anav) tWauanduy OSD
(MsUFAYHALUKUIRA)

An "Down Arrow" (§nesav) Wialdan
sailan "Color" (]) annduna "OK"
(anav) Wangnisaeaiy, dnisavan 3
ALNIGILRAIATURY

1. Color Temperature (aeuu)fix): Wia
mimomaﬂ‘lumo 6500K “unaaay
ﬂﬁn;]l,ﬂuimu au TaafInudune-
217" _‘luwmmamuﬂuﬁm 9300K Y
WA "fu Wwinugvh-an"



2. sRGB: uLﬂumsmmmmgmmalu
uu‘lammmamﬂaﬂumanmawao
&szvoailnsaiiuananodiu (Lafu
NRDIAANAR, IANN, LATAITUN,
JUAULUAT, 1)

3. User Define (slrifinuua): sz
gansadananuzraulunisaad
22967129 1eansiuiuag &
uazdiidu

S uuaLn

nsiad virlagmsiaduasugeanningfuniodlu
2auggaviniusautiu msialignuaaslugluuy
229105 IALLLRNYTA (29AILARIY) aunliid
Lﬂmum w2iu 2004K Huguns; aanniifinaiu
ﬂamu L‘].i‘u 9300K tilu&indu aaunQfisssN6 Aa

&2 agil 6504K

A1au 9: mmsmﬂauﬂaaan'\w LCD
iléive PC nsnmmﬁu 1%
Mac msaoimnvlm’tﬂnsa”lu?

fau: Taf aanw LCD Philips nniadag
gunsavitusuduladu PC
1Nas51Y, Mac uay mnamﬂua
maauusm ﬂmmamtﬂumaaw

azualinasanaadaiadauna

aanwlideseuy Mac aasna
Tﬂsmmmmamumuammu Ph|||ps
wammdmsnmaumwmmu

énew 10: 32w LCD Philips uluszuu
wan- uaum auusalu?

nau: it WA 9 dunuuwdn-
waua-twat Mlmnusrufulady
Windows 8/7/Vista/XP/NT, Mac
0SX, Linux

éeu 11: awdaninaa wsanwis
udu u3anIwAY usanning
nluniunaa LCD Aaar'ls?

fa: ms"lummamvmsu,ammw
uomﬂmmmuamﬂusu HYIAN
Uu mam‘lmnmms "Li‘lsuau
mamsannu’tumms mwmo
wia "mwinam" UUNUIIBADY
AL a1nlg “L'ﬁsuau" "ATWANY"
kR "IINTnEs" Lﬂuﬂswnamsm
fisdnAudlumaTuladninag
LCD &umnaua) a1ns "ils
udu" wia "nnwAe” wia "an
Tnaa" agaag 9 wigldlanan

a1l ndvaniidaesag Lf[ml
viuldsunsuandutaniasig
msedaulmiiana Waaailaas
anwiehilaglulalzdou s
mmuuaﬂwmm‘.‘fuiw\lsﬂumaa
viluszage w@ua a1aan 1w LCD
2a9naiazuaadLiiavAdunw
fodtalufinsldauuias

0 édiau
a1A15 "Lisudu" via "awee” wia "awn
Tnaa" Nqunsy agluwmell uagluguisa

siauua’le AmNudaafinanfeaiuuuly
Tasuanuauasasnalanisiulseiuuasna

Mo 12: vin'luaaudnsWaddluuang
mam'mvmwﬂm UAZUAMIG?
Snusiifisaaniin? 3

fawu: AW LCD vavqavinaulad
Agafianuandoafiundouas
msaaﬂa 1920 x 1080 @ 60Hz

Lwamsuamwammmam Tlsala
ANuasdaai

fam 13: azlandan/fanluaiunasiu
auv'ls?

fau; Tsana &)/0K wunan 10
mwmwaﬂamaaﬂ/aanﬂumu
Taansvinuiiu aanwuasna

sudgazamN "Usznnd” duin

LwaLLamamuvmaomsﬂamaaﬂ/

dan mmuam‘lumw AIUR

Attention

Monitor control unlocked

Attention

Monitor control locked
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fd1a1u 1: Suluuiuaingilnsaiiiada

maaﬁuuuuﬁ'\aammaan'\w

AnaU:

AU 2. it lunInuuKuIaA2IDAIN

Tisaasagaialnsaifiadanasnalla
Fun1s5usay MHL w3a'lu

uananil ﬂmm:nl,ﬂumaoumummam
"Lmnmﬁusao MHL LwaLﬁaumaaﬂﬂsm
Snane

maam‘lmtu‘tmmm”lmL’i\‘anmatmn‘u
wasm MHL-HDMI LLauLaanauwmman
Qaau‘qaan’mmumtaanauwm (]
AUKUY u3a OSD)

naasu lasun1s5usay MHL agnailu
19n15 wavanaanwiidulaugana
WUUWIRDW mnmwuﬂmmm"l,u"l,mmm
winalag ’Lummm‘tﬂauwm MHL Tisa
mﬂmawlmaoaﬂnsmuana mammmaw
nanainsaifiada

Attention

No video input(MHL-HDMI)

aaginuulanaglnsaifiadavasnanly
"mea‘immaumummﬂ (aaﬂ) anudly
wiuiiu AaiaziiutanuuRBauLy
DUIAIHA mgmnmqﬂnsmuaaamgo
AMGUAUNN NUIABUBIABNIWALAUAY
Nuazudasnw A lupansIagiu
wulanlalandunaignaas annaull
nstavdaiaunaalnsaidug lusemng
|

Fefiaauninen? ailnsaifiada
AaIRURGRAIMIUIA

Aqnau:

Wes5IU MHL wudiniivue 1080p
@30hz mmamsmmmwmm"auwm
aamwuaamﬂaaonummgwuu

ﬂmmwmaamwmuaﬂnnﬂmmwmaa
Luammuanu mtuamummauaum
§9 (éhaeneiu HD vida 1080p) wiam
azisnglusduuy HD w3a 1080p uu
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auRaaUIa TNy

fd1aau 3. Suliledudavannuuiaauay
AN

deau:

« anaglunulanaaswuanaiiaiTwe
Tud waziflaszdudeelhvidouas
VAN LLaypTwaoaﬂnsmuaaamu
uananil ﬂmmmamaomswuﬁamﬂu
alnsalsBuais

« gnaamwzadnaluda Twolud Ao
mmsnLﬂaumauﬂamﬂuaﬂnsmﬁaqu
nAuaIawazasaanw Tsaiulan ;
sydudavgnidaagidonasaanin uasil
donavailnsaisiada

dusuzayaniudu uia FAQ Tusagil
Wulaieasgeilunivnisuas MHL org:

http://www.mhlconsortium.org
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